控制台中的工作
[bookmark: _GoBack]概述
RStudio控制台包含许多使R工作更为有效和直观的特征。本文综述这些特征。学习使用这些特征以及Source和History窗口中可用的相关特征可以对你使用R的效率有实际性的帮助。
[bookmark: completion]代码补全
RStudio支持使用Tab键来自动补全代码。例如，如果你在工作空间中有名为pollResults的对象，你可输入poll然后按Tab键，RStudio将自动完成该对象的全名。
代码补全特征同样提供了尽可能的嵌入式帮助。例如，如果你可输入sub然后按Tab键，你将看到：
[image: Using console completion]
代码补全还可以对参数功能进行工作，如果你可输入subset(然后按Tab键，你将看到：
[image: Using console completion args]
Retrieving Previous Commands 检索以前命令
当你使用R进行工作，你将经常可输入重新执行你之前输入的命令。与标准的R控制台一样，RStudio控制台支持使用以下方向键回忆之前命令的功能：
· Up —回忆前一条命令；
· Down —回Up相反；
    如果你希望回顾你当前的命令列表并从中选择一条命令，则可使用Ctrl+Up来回顾命令列表（注意：在Mac你还可使用Command-Up）
[image: Using console history popup]
你还可以使用同样的快捷键来快速查找匹配给定前缀的命令。例如，查找前面出现过的plot函数，先输入plot然后Ctrl+Up
[image: Using console history search popup]
控制台标题栏
这个截屏阐明了控制台标题栏的一些额外功能。
· 显示当前工作目录；
· 能够在一个长期的计算里中断R；
· 最小化和最大化Console和Source窗口（使用右上按钮或双击标题栏）
[image: Using console title bar]
快捷键
     除了上述的历史和代码补全快捷键外，还有很多其他快捷键可用，其中最为有用的快捷键包括
· Ctrl+1 —移动焦点到Source编辑器。
· Ctrl+2 —移动焦点到Console。
· [bookmark: OLE_LINK12][bookmark: OLE_LINK11]Ctrl+L —清理控制台；
· Esc —中断R
    你可从Keyboard Shortcuts文中找到所有快捷键列表。
相关主题
· Editing and Executing Code  编辑和执行代码
· Using Command History 使用命令历史



编辑执行代码
概述
RStudio的souce编辑器包含各种提高效率的特征，包括语法高亮显示，代码自动补全，多文件编辑以及查找和替换。
[bookmark: OLE_LINK13][bookmark: OLE_LINK14]RStudio还可以使你直接通过source编辑器灵活地执行R代码。对于许多R开发者来说，这是他们使用R的首选方式。通过source编辑器执行命令相对于控制台来说更便于复制命令序列和将其做为再次使用的函数进行打包；这些特征将在后面的执行代码部分讲解。
文件管理
Rstudio支持语法高亮显示和其他专业化的代码编辑功能，针对以下类型文件。
· R scripts   R脚本文件
· Sweave documents   Sweave文件
· TeX documents  Tex文件
你可通过File -> New菜单创建新文件。（你也可使用Ctrl+Shift+N快捷键）。
[image: Source new menu]
[bookmark: OLE_LINK17][bookmark: OLE_LINK18][bookmark: OLE_LINK32][bookmark: OLE_LINK31]你可通过File -> Open菜单或者Open Recent菜单选择来打开已有文件。（你也可使用Ctrl+O快捷键）。
如果你通过RStudio打开许多文件，那么他们都可以通过标签进行快速切换。如果你有大量的打开文件，你也可在它们间通过标签栏中的>>图标来进行导航，或者View -> Switch to Tab菜单项（你也可使用Ctrl+O快捷键）。
[image: Source tabs]
代码补全
RStudio可以使用Tab键来支持代码自动补全，例如，如果你在工作空间中有名为pollResults的对象，你可输入poll然后按Tab键，RStudio将自动完成该对象的全名。
[image: Source completion]
代码补全同样在控制台中工作，具体用法可间控制台代码自动完成Code Completion文档。
查找和替换
 Rstudio支持在source文件中查找和替换。
[image: Source find replace]
可使用Ctrl+F快捷键来打开查找和替换栏，或者使用Edit -> Find and Replace菜单项。
提取函数
[bookmark: OLE_LINK30][bookmark: OLE_LINK29]RStudio可以在source编辑器中分析一组选择的代码，并自动将其转化成再次使用的函数。任何选择中的"free"变量（选择引用对象但不创建）将转化为函数参数。（你也可使用Ctrl+Shift+U快捷键）。

[image: Source extract function]
注释/取消注释
你可使用使用Edit -> Comment/Uncomment Lines菜单项来对所选的整个代码进行注释或取消注释（你也可使用Ctrl+Shift+C快捷键）。

[image: Source comment]
首行缩进
如果你在RStudio中写R代码，他将自动根据当前的缩进选项（见Customizing RStudio）进行缩进。R代码也可再缩进。
当新代码黏贴到一个source文件中；
当缩进行命令（上图）被调用
注意：RStudio自动缩进针对的是R语法意识，因此，只有在包含R代码的source文件中使用
[bookmark: executing]执行代码
   RStudio支持从source编辑器中直接执行代码（执行代码将插入控制台，并在此输出结果），
执行一行代码
你可通过Ctrl+Enter键来执行当前光标所在行的source代码（或者使用Run工具条按钮）
[image: Source execute line]
[bookmark: OLE_LINK23][bookmark: OLE_LINK24]执行完一行代码，RStudio自动将光标跳到下一行，这将使你可以在一系列行中单步执行代码。
执行多行代码
有三种方法从编辑器中执行多行代码。
· 选择这些行，按Ctrl+Enter键（或者使用Run工具条按钮）
· 执行选择的代码后，使用Re-Run Previous Region命令（或相应的工具栏按钮）再次运行相同的选择。注意：现在发生变化，包括增增加、删除和修改行将反映到后续运行中。（或者使用Ctrl+Shift+P快捷键）
· 运行整个文件按Ctrl+Shift+Enter键（或使用source工具条按钮）??
[bookmark: OLE_LINK27][bookmark: OLE_LINK28]从选择的行进行运行和调用Source的区别在于，当运行所选的所有行将直接插入到控制台中，而对于Source文件则保存到临时位置然后从那里反映到控制台（因此在控制台中产生较少的杂乱）。
资源保存
当编辑一个再次调用函数（相对于独立的R行而言），你可能希望对文件设置Source on Save选项（通过工具条中Save图标的后一项实现）。启用该选项导致文件每次保存都将被全球自动采用。
设置Source on Save选项确保该函数的版本在全球环境总是能够资源同步，并且也能在你开发一个函数是提供一种好的方式安排频繁的语法检查。
快捷键
除了上述的快捷键外，还有很多其他快捷键可用，其中最为有用的快捷键包括。
· Ctrl+Shift+N — New document   新文档
· Ctrl+O — Open document  打开文档
· Ctrl+S — Save active document   保存活动文档
· Ctrl+1 — Move focus to the Source Editor   移动焦点到Source编辑器
· Ctrl+2 — Move focus to the Console   移动焦点到控制台  
相关主题
· Working in the Console   在控制台中工作
· Using Command History   使用历史命令
· Navigating Code  代码导航
· Code Folding and Sections  代码折叠和截取 



代码折叠和截取
代码折叠
[bookmark: OLE_LINK36][bookmark: OLE_LINK35]RStudio支持自动和使用者定义的地区代码折叠。代码折叠允许你很方便地显示和隐藏代码块，这将使你的source文件导航更简易，并可以将中重点放在手头的代码任务上。例如，在下面的source文件中plot.autoregressive.model部分已经被折叠。
[image: Codefolding basic]
你可展开折叠部分，通过点击箭头槽或者覆盖折叠代码的图标。
折叠区域
RStudio中以下类型的代码区域将自动折叠：
· 支撑区域（函数定义、条件块等）
· R Sweave的代码块或者是R的Markdown文件。
· 代码段（具体见后文）
在以下案例中，即将看到顶级代码部分、函数体和条件块都被折叠。
[image: Codefolding regions]
你也可折叠任意选定的代码，通过Edit -> Folding -> Collapse，或者使用Alt-L快捷键。
[bookmark: OLE_LINK42][bookmark: OLE_LINK41]折叠部分在编辑文件时将被保证，但是当文件关闭或者再次打开时，所有折叠部分将默认展开显示。
代码段
[bookmark: OLE_LINK45][bookmark: OLE_LINK46]代码段允许你将一个大型的source文件分解成一组独立的区域以方便再他们之间漫游。代码段将自动折叠，例如，以下源文件有三个部分（一个展开而另两个折叠）。
[image: Codefolding sections]
插入一个新的代码段你使用Code -> Insert Section命令。或者，任意注释行中包含至少四个破折号（-），等号（=）或井号（#）将自动创建代码段。
 # Section One ---------------------------------
 
 # Section Two =================================
 
 ### Section Three ############################# 
注意：如前所述，可输入超过4个或更多的数量的#号，-，=等。
[bookmark: OLE_LINK49][bookmark: OLE_LINK50]你可使用编辑器低端的Jump To菜单在代码段间漫游（或者使用Alt+Shift+J快捷键）。
[image: Codefolding jumpto]

菜单命令和快捷键
以下菜单命令和快捷键可以对折叠区域和代码段进行操作：
· Edit -> Folding: 
· Collapse — Alt+L 
· Expand — Shift+Alt+L 
· Collapse All — Alt+A 
· Expand All — Shift+Alt+A 
· Code: 
· Insert Section — Ctrl+Shift+R (Cmd+Shift+R on the Mac) 
· Jump To — Shift+Alt+J 
注意：Collapse All命令折叠所有外层可折叠区域（而不是源文件中的所有嵌套区域）
Related Topics
· Navigating Code   导航代码
· Editing and Executing Code  编辑和执行代码



导航代码
RStudio包括一些在R源代码中加速导航的功能。学习这些功能可以提高效率并帮助更好地理解你的团队中其他人所写的源代码，或者是外部程序包中的源代码。
查找文件
[bookmark: OLE_LINK52][bookmark: OLE_LINK51]    给出一个特定目录，查找文件（Edit->Find in Files）允许你对每个出现的字符串递归查找每一个文件。显示查找文件对话框，编辑菜单并选择查找文件：
[image: Navigate find files]
    你可以进一步通过正式表达式和特定文件类型来自定义你的搜索。你的搜索结果将显示在控制台的相邻窗口中。每一个匹配的字符串都将显示以下信息：
· The file path   文件路径
· The line number of each occurrence   每个出现的行号
· The matching string (highlighted), in the context of the current line  
· 当前行内容中匹配的字符串（高亮）
[bookmark: OLE_LINK54][bookmark: OLE_LINK53]    双击这一行，将在RStudio的source编辑器中打开该文件。查找文件的快捷键是Ctrl+Shift+F。
转到文件/函数
     如果你知道源文件或函数的名字并想对其进行编辑，你可以使用RStudio工具条中的Go to File/Function搜索框迅速导航。
[image: Navigate file function]
    Go to File/Function功能就不断更新索引你的源代码。专业源文件的索引将决定于：
1.RStudio Project是活动的，然后所有的R源文件在程序包列表中将被索引；
2.如果一个Project不活动，那么所有当前打开的R源程序将被索引；
Go to File/Function的快捷键是Ctrl+.
转到函数定义
当一个你的R源代码指数（如上所述）被维护，RStudio也可帮助你迅速对任何R函数进行导航。你可将光标放在函数名称上（不需要完全选定）来导航函数定义，然后选择Go to Function Definition命令：
[image: Navigate function definition]
你也可这样去访问函数定义：
· Using the F2 keyboard shortcut    使用F2快捷键
· Using Ctrl+Click with the mouse   使用Ctrl+Click鼠标点击
· [bookmark: OLE_LINK57][bookmark: OLE_LINK58]From either the source editor or the console   从source编辑器或控制台
它同样能够导航你自己的函数（在R源文件中定义）和其他所有在R程序包中定义的函数。程序包中定义的函数，其代码将显示在特定的Source Viewer窗口中，它仅能只读不能编辑，但可以复制粘贴出来使用。
源文件导航
[bookmark: OLE_LINK64][bookmark: OLE_LINK63]   有多种方式可以对源文件中的代码进行导航：
· 上述的go to function definition功能同样可以对当前源文件的函数进行工作（在调用范围中给出函数定义优先级。
· Jump to Line命令（快捷键Command+G)）可用于转到当前文件的任意一行；
· 你也可使用函数命令（如下显示），通过名称迅速跳到函数。
[image: Navigate jump to function]
[bookmark: OLE_LINK65][bookmark: OLE_LINK66]注意：当前函数菜单支持标准R函数，但是不支持S4方法。
向前与向后
当代码导航（特别是在一系列函数中导航），你经常要快速返回之前编辑的位置。RStudio维护有一个活动的导航列表，允许你使用Back和Forward命令（Edit菜单中或在source编辑条的最左边）进行来回遍历。
    Back和Forward适用于以下导航方式：
· Opening a document (or switching tabs)  打开一个文件（或切换标签）
· Going to a function definition  转到函数定义
· Jumping to a line  跳到一行
· Jumping to a function using the function menu 使用函数菜单跳到一个函数
[bookmark: OLE_LINK69][bookmark: OLE_LINK70]    你同样可以使用快捷键Ctrl+F9/Ctrl+F10 (Cmd+F9/Cmd+F10 on the Mac)来调用Back和Forward：



使用项目
RStudio项目直接让你的工作多语境，每一个自带工作目录、工作空间、历史和源文件。
创建项目
   RStudio项目与R工作目录相连，你可通过以下方式创建RStudio项目：
· 在全新的目录下；
· 在现有的你已存放有R代码和数据的目录下；
· 通过克隆一个版本控制（Git或Subversion）元数据库；
    可使用创建New Project命令（在Projects菜单中）一个新项目。



使用命令历史
[bookmark: OLE_LINK77][bookmark: OLE_LINK78]RStudio维护有所有你曾输入控制台的命令的数据库，你可使用历史窗口来浏览和搜索这个数据库。
浏览历史
你之前输入RStudio控制台的命令可以通过历史标签进行浏览，这些命令将按顺序显示出来（最近的命令在底部）并按时间分组。
[image: History browse]
搜索历史
执行一个搜索
你可使用历史窗口右上角的搜索栏搜索之前命令的所有实例（例如plot）。搜索可进一步根据添加的用空格隔开的单词来进行再次查找（例如一个特定的数据集）。
（[image: History search]
显示命令上下文
    在你的历史中搜索完一个命令后，你可能希望看到与之接近的其他命令。点击搜索结果的右侧边缘的箭头，你将看到命令的上下文。
[image: History context]
使用命令
    在历史窗口中所选的命令可以通过两种方式进行使用（对应历史工具栏左侧的两个按钮）：
· [bookmark: OLE_LINK83][bookmark: OLE_LINK84]To Console—将所选命令发送到控制台。注意命令插入控制台后直到你按Enter键才会执行。
· To Source—将所选命令发送到当前活动的源文件。如果当前没有源文件则将创建一个新的未命名的源文件。
    历史列表中，你可选择单个命令或者多个命令（按住Ctrl键不连续多选或按住Shift键选择连续的命令段）：
[image: History multiple select]
  
相关主题
· Working in the Console   在控制台中工作
· Editing and Executing Code  编辑和执行代码



工作目录和工作空间
    R对所操作的.RData文件和工作空间的默认行为支持和推动将工作环境划分为不同目录的模型。本文阐述RStudio支持这种工作流程的多种功能，
重要提示：在RStudio v0.95中，一个新的项目功能被引入进来以使得多个工作目录的管理更直接。以下阐述的功能仍然工作，尽管项目作为推荐机制来处理多个工作环境。
默认工作目录
    与标准的R GUI一样，RStudio采用全局默认工作目录的概念。通常这是使用者的主目录（通常参考R中使用~）。当RStudio开始他将如下操作：
· 运行默认工作目录下的.Rprofile；
· 装载默认工作目录下的.RData 文件到工作空间中；
· 执行其他活动描述在R Startup中
    当RStudio退出和工作空间发生变化，一个提示将问及是否保存这些改变到当前工作目录的.RData文件中。
    可使用RStudio Options对话框通过以下方式来自定义默认行为：
· 改变默认工作目录；
· 启用/禁用开始时从默认工作目录中装载.RData；
· 指定.RData退出时是否总是保存、不保持或者提示保存。
修改工作目录
   当前的工作目录显示在RStudio控制台的标题区域。有多种方法可以改变当前工作目录：
· 使用R函数setwd;
· 使用Tools | Change Working Dir...菜单，他也将改变文件窗口的目录位置；
· 从文件窗口中使用More | Set As Working Directory菜单。（在文件窗口中导航将不改变工作目录）
    考虑改变你的工作目录请小心，它有以下副作用：
· 应用你代码中的相关文件（如数据集、源文件等）将无效，当你改变工作文件；
· .RData退出时所保持的位置将改变到新目录中；
    因为这些副作用可能导致迷失和错误，最好是通常从与你项目相连的工作目录开始，并保持在那里进行你的操作。后文将阐述怎样设置RStudio的初始工作目录。
开始其他工作目录
    如果所有的文件与一个包含在单个目录下的项目相关，那么你最好从那个目录开始RStudio。有多种方式（平台不同将有所变化）来实现这个。
文件关联
    RStudio的所有平台自己注册成一个处理程序如.RData，.R和其他R相关文件类型。这意味着系统文件浏览器的上下文菜单将对在RStudio对这些文件进行开放选择。
   你也可以有选择地创建RStudio和.RData或.R文件的默认关联。
   当开始通过了一个文件关联，RStudio将自动设置工作目录到打开文件的目录。注意RStudio当它已经运行也可通过连接打开文件——在这种情况下，RStudio仅打开文件，但不改变工作目录。
快捷键(Windows)
   在Windows中，你可创建一个RStudio快捷键来自定义“Start in”部分。当启动这个RStudio快捷键，将通过特定工作目录来开始。
Drag and Drop (Mac)
On Mac, dragging and dropping a folder from the Finder on the RStudio Dock icon will cause RStudio to startup with the dropped folder as the current working directory.
Run from Terminal (Mac and Linux)
On Mac and Linux systems you can run RStudio from a terminal and specify which working directory to startup within. Additionally, on Linux systems if you run RStudio from a terminal and specify no command line argument then RStudio will startup using the current working directory of the terminal.
For example, on the Mac you could use the following commands to open RStudio (respectively) in the '~/projects/foo' directory or the current working directory:
$ open -a RStudio ~/projects/foo
$ open -a RStudio .
On Linux you would use the following commands (note that no '.' is necessary in the second invocation):
$ rstudio ~/projects/foo
$ rstudio
Handling of .Rprofile
When starting RStudio in an alternate working directory the .Rprofile file located within that directory is sourced. If (and only if) there is not an .Rprofile file in the alternate directory then the global default profile (e.g. ~/.Rprofile) is sourced instead.
装载和保存工作空间
  如果你想在RStudio回话过程中保存或装载工作空间，你可使用一下命令从当前工作目录下的.RData文件来进行保存和装载。
> save.image()
> load(".RData")
   注意：load函数
> rm(list=ls())
Note that since loading is handled at startup and saving is handled at exit, in many cases you won't require these commands. If however you change working directories within a session you may need them in order to sync your workspace with the directory you have chanaged to.
The RStudio Workspace menu also includes items that execute the above described commands, as well as enables you to load or save specific .RData files.
处理.Rhistory
The .Rhistory file determines which commands are available by pressing the up arrow key within the console. By default, RStudio handles the .Rhistory file differently than the standard R console or GUI, however can be configured to work the same was as those environments if you wish.
The conventional handling of .Rhistory files is as follows:
· Load and save .Rhistory within the current working directory 
· Only save the .Rhistory file when the user chooses to save the .RData file 
Whereas the default RStudio handling of .Rhistory files is:
· Load and save a single global .Rhistory file (located in the default working directory) 
· Always save the .Rhistory file (even if the .RData file is not saved) 
The RStudio defaults are intended to make sure that all commands entered in previous sessions are available when you start a new RStudio session. If you prefer the conventional R treatment of .Rhistory files you can customize this behavior using the General panel of the Options dialog.



自定义RStudio
概述
   RStudio可通过Tools : Options菜单的选项对话框来进行，包括以下类：
· General R Options — Default CRAN mirror, initial working directory, workspace and history behavior. 
· Source Code Editing — Enable/disable line numbers, selected word and line highlighting, soft-wrapping for R files, paren matching, right margin display, and console syntax highlighting; configure tab spacing; set default text encoding. 
· Apperance and Themes — Specify font size and visual theme for the console and source editor. 
· Pane Layout — Locations of console, source editor, and tab panes; set which tabs are included in each pane. 
· Sweave — Configure Sweave compiling options and PDF previewing. 
· Spelling — Choose main dictionary language and specify spell checking options. 
· Version Control — Configure locations of Git and Svn binaries and create and/or view SSH RSA keys. 
[bookmark: general]Details on the various settings are provided in the sections below.
一般的R选项
[image: Options general]
· Default working directory — Startup directory for RStudio (when not in a project). The initial .RData and .Rprofile files (if any) will be read from this directory. The current working directory and Files pane will also be set to this directory. Note that this setting can be overridden when launching RStudio using a file association or a terminal with a command line parameter indicating the initial working directory. 
· Save workspace to .RData on exit — Ask whether to save .RData on exit, always save it, or never save it. Note that if the workspace is not dirty (no changes made) at the end of a session then no prompt to save occurs even if Ask is specified. 
· Restore .RData into workspace at startup — Load the .RData file (if any) found in the initial working directory into the R workspace (global environment) at startup. If you have a very large .RData file then unchecking this option will improve startup time considerably. 
· Always save history (even when not saving .RData) — Make sure that the .Rhistory file is always saved with the commands from your session even if you choose not to save the .RData file when exiting. 
· Remove duplicate entries in history — Prevent addition of commands to history if they are the exact same as the most recently added command. 
· CRAN mirror — Set the CRAN mirror used for installing packages (can be overridden using the repos argument to install.packages). 
· Restore most recently opened project at startup — When opening RStudio automatically re-open the most recently used project. 
[bookmark: editing]
源代码编辑
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· Highlight selected word — Add a background highlight effect to all instances of the currently selected word within the document. 
· Highlight selected line — Add a background highlight effect to the currently selected line of code. 
· Show line numbers — Show or hide line numbers within the left margin. 
· Insert spaces for tab — Determine whether the tab key inserts multiple spaces rather than a tab character (soft tabs). Configure the number of spaces per soft-tab. 
· Show margin — Display a margin guide on the right-hand side of the source editor at the specified column. 
· Automatically insert matching parens/quotes — When typing a paren, quote, or brace automatically insert a matching one and position the cursor between them. 
· Soft-wrap R source files — Wrap lines of R source code which exceed the width of the editor onto the next line. Note that this does not insert a line-break at the point of wrapping, it simply displays the code on multiple lines in the editor. 
· Show syntax highlighting in console input — Apply R syntax highlighting to the console input line. 
· Default text encoding — Specify the default text encoding for source files. Note that source files which don't match the default encoding can still be opened correctly using the File : Reopen with Encoding menu command. 
[bookmark: appearance]
外观和主题
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· Editor font — Customize the font for panes which display code (Console, Source, History, and Workspace). 
· Font size — Set the font size (in points) for panes which display code (Console, Source, History, and Workspace). 
· Editor theme — Specify the visual theme for the Console and Source panes. You can preview the theme using the inline preview or by pressing the Apply button. 
[bookmark: pane-layout]
窗体布局
[image: Options pane layout]
· Specify the location and tab sets of panes within RStudio. 
· Each of the 4 panes is always displayed (it isn't currently possible to hide a pane). 
[bookmark: sweave]
Sweave  
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· Weave Rnw files using — Choose the default global option for weaving files with the Compile PDF button. (See Weaving Rnw Files for additional documentation). 
· Typeset LaTeX into PDF using — Choose from a list of supported typesetting engines or add a customized one (See additional help for Customizing LaTeX Options ). 
· Use texi2dvi to resolve cross-references — texi2dvi is utility program included in TeX distributions which automatically runs (and re-runs) the LaTeX, bibtex, and makeindex programs as necessary to correctly resolve all cross-references. You should only disable this option if you have a specific reason not to use texi2dvi (such as a known bug you need to work around). When this option is disabled RStudio will attempt to emulate the behavior of texi2dvi by directly calling the LaTeX program, bibtex, and makeindex as necessary to fully compile the PDF. 
· Clean auxiliary output after compile — Running the LaTeX program produces various intermediate files (e.g. 'target.out', 'target.aux'). Enabling this option causes these files to be automatically removed after the compile. Note that log files ('target.blg' and 'target.log') are also cleaned up, however they are preserved if errors occur during compilation. 
· Enable shell escape commands — Enable execution of shell commands using \write18 by passing the -shell-escape option to the LaTeX program. This option is disabled by default because allowing documents to execute embedded shell commands may pose a security risk. 
· Insert numbered sections and subsections — Specifies that sections and sub-sections inserted using the Format menu should include numbering (if this option is not enabled then sections will be inserted as \section*). 
· Preview PDF after compile using — Choose which application to view your PDF file with after the compile is complete. (See additional help for PDF Preview ). 
· Always enable Rnw concordance — Automatically set the options required to emit concordance information during Rnw weaving. Concordance provides a mapping between line numbers in the Rnw file and the generated TeX file. This enables both direct navigation to compilation errors within Rnw files and compatibility with Synctex for PDF previewing. 
[bookmark: spelling]
拼写
[image: Options spelling]
· Main dictionary language — RStudio's default installation includes English dictionaries for the US, UK, Canada, and Australia. In addition, dictionaries for 28 other languages can be installed. For additional information on dictionaries, see the Spelling Dictionaries documentation. 
· Custom dictionaries — You can also configure RStudio to use Hunspell custom dictionaries that include additional terms commonly used within your field (for example, the OpenMedSpel dictionary of medical terms). For additional information on customizing dictionaries, see the Spelling Dictionaries documentation. 
· Ignore words in UPPERCASE — Ignore words in all UPPERCASE letters while spell checking 
· Ignore words with numbers — Ignore words with numbers while spell checking 
[bookmark: version-control]
版本控制
[image: Options version control]
· Git executable — Location of Git executable. By default RStudio locates the Git executable in the system path. If you want to use a version of Git not on the path you can specify it here. 
· SVN executable — Location of SVN executable. By default RStudio locates the SVN executable in the system path. If you want to use a version of Git not on the path you can specify it here. 
· SSH RSA Key — When using SSH with RSA public/private key authentication against a remote Git or Subversion repository you need to generate an RSA key and then provide the public key to the remote server. You can both create a new RSA key and view/copy its public key within the Version Control options panel. 
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